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COURSE CONTENTS. Adobe photoshop cc 2017. 

Module-Ii adobe photoshop (cc 2017)………………….30 Days. 
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Adobe Photoshop CC 2017. 
 

Chapter-1. What Is Adobe Photoshop? Adobe Photoshop is an application or popular image 

editing software and used to graphics world and user can edit, modified, repaired, and alter 

images. Digital scanner and photography. You can used to adobe Photoshop web publishing. 
 

Extensions Name of Adobe Photoshop File.  .PSD (Adobe Photoshop). 
 

How to Open Adobe Photoshop CC 2017? 
 

Click on Start Button > Programs > Adobe Photoshop Folder > Adobe Photoshop CC 2017. 
 

Click on Window Button > Search > Type > Adobe Photoshop CC 2017. > Enter. 
 

Double Click on Adobe Photoshop CC 2017. Icon on Desktop. 
 

Title Bar. A horizontal bar at the top of a window, bearing the name of the program and 

typically the name of the currently active document include three button minimize, maximize 

and close button. Or display the title of the open document. 
 

Menu Bar. Adobe Photoshop customization features let you modify the menu bar and the 

menus it contains. You can change the order of menus and menu commands; add, remove, and 

rename menus and menu commands. You can search for a menu command if you do not 

remember the menu in which it belongs. You can also reset menus to the default setting. The 

customization options apply to the menu bar menus as well as to shortcut menus that you 

access by right-clicking. 
 

Tool Box. The toolbox contains tools for drawing and editing images. Some of the tools are 

visible by default, while others are grouped in flyouts. Flyouts open to display a set of related 

Adobe Photoshop tools. A small flyouts arrow in the lower-right corner of a toolbox button 

indicates a flyout. You can access the tools in a flyouts by clicking the flyout arrow. After you 

open a flyout, you can easily scan the contents of other flyouts by hovering over any of the 

toolbox buttons which have flyout arrows. Flyouts function like toolbars when you drag them 

away from the toolbox. This lets you view all the related tools while you work. 
 

Document Tab. A tab displays for each open document to allow you to quickly move between 

documents. 
 

Update Text Toolbar. A temporary toolbar that allows you to update documents created in 

Adobe Photoshop CC (or earlier) in order to edit the text. 
 

Drawing Window. The area outside the drawing page bordered by the scroll bars and 

application controls. 
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Property Bar. A detachable bar with commands that relate to the active tool or object. For 

example, when the text tool is active, the text property bar displays commands that create and 

edit text. 
 

Docker. A window containing available commands and settings relevant to a specific tool or 

task. 
 

Rulers. Horizontal and vertical borders that are used to determine the size and position of 

objects in a drawing. 

Document Palette. A dockable bar that contains color swatches for the current document. 
 

Document Navigator. The area at the bottom left of the application window that contains 

controls for moving between pages and adding pages. 
 

Drawing Tools. Draw resolution-independent vector shapes instantly with the line, rectangle, 

ellipse, polygon, and custom shape tools. Or use the pen tool to draw just as you would in 

Adobe Photoshop. Because they’re vector shapes, you can edit them easily. 
 

Status Bar. An area at the bottom of the application window that contains information about 

object properties such as type, size, color, fill, and resolution. The status bar also shows the 

current cursor position. 
 

Navigator. A button at the lower-right corner that opens a smaller display to help you move 

around a drawing. 
 

History Palette. Undo or redo multiple steps with the history palette. Or store a snapshot a 

temporary copy of the image in the palette, and continue experimenting. If you don’t like the 

results, simply return to the snapshot. You can also create multiple snapshots, capturing 

different effects, to compare them easily. 
 

File Browser. Quickly inspect images before opening them in Adobe Photoshop CC. The 

easy-to view file browser displays thumbnails and metadata such as date modified, 

dimensions, and EXIF information from your digital camera. You can also use the file browser 

to sort files and manage folders. 
 

Layers. With layers, you can work on one element without disturbing others. To rearrange 

elements, simply shift the order in the layers palette. You can lock layers to prevent accidental 

changes, hide them to get a clear view of the element you’re working on, and link layers to 

move them as a group. The Layers palette also makes it easy to apply instant, editable effects 

including blending modes, adjustment layers, and layer effects. 
 

Options Bar. The tool options bar gives you instant access to different settings for the tool 

you’re using. You can also customize any tool and save the customized version to use again. 
 

Customizable Workspace. Personalize your Adobe Photoshop CC desktop by arranging a 

layout of palettes and saving the arrangement as a workspace. Or create task-specific 
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workspaces— one to provide easy access to painting tools, for example, and another for photo 

retouching. 
 

Layer Effects. Shadows, glows, bevels, embossed effects, and more with the layer styles 

dialog box, adding three-dimensional effects to a layer is quick and easy. You can apply any 

combination of layer effects, then save the combination as a style and apply it to other layers 

instantly. To edit or delete the effect, simply open the layer styles dialog box and change the 

settings. 
 

Filter Effects. Adobe Photoshop includes more than 95 special effect filters-from fine-art 

effects, to motion blurs, to lighting effects and distortions. 
 

Web Photo Display. Showcase your work online by posting a web photo gallery. You’ll find 

a collection of ready-made templates on the Photoshop CD to make the job quick and easy and 

you can stamp each image with copyright text to help protect against illegal downloads. 
 

Welcome Screen. The Welcome screen gives you easy access to application resources and 

lets you quickly complete common tasks, such as opening files and starting files from 

templates. You can also find out about the new features in Adobe Photoshop CC and get 

inspired by graphic designs featured on the gallery page. In addition, you can access videos 

and tips, receive the latest product updates, and check your membership or subscription. 
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Chapter-2. Adobe Photoshop CC Tools? 
 

 

 

Move Tool (V). The Move tool is used to move selected layers around. Clicking and 

holding the mouse button can adjust the positions of layer elements.  This tool is also used to 

set and move guide lines. The move tool simply lets you move objects in a given layer around 

the Photoshop canvas. To use it, click anywhere on the canvas and drag. As you drag, the 

Photoshop layer will move with your mouse. 
 

Art Board Tool (V). You can think of an artboard as a special type of layer group. An 

artboard clips the contents of any contained elements to its boundaries. The hierarchy of 

elements in an artboard is displayed in the layers panel, together with layers and layer groups. 

Artboards can contain layers and layer groups, but not other artboards. Visually, artboards 

serve as individual canvases within a document. Any layers in the document not contained 

within an artboard are grouped at the top of the layers panel and remain unclipped by any 

artboards. 
 

Menu. 

Toolbar. 

The Image. 
Layers. 

Swatches. 

Info. 
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Rectangular Marquee Tool. (M). This tool allows the user to select rectangular shaped 

areas within an image.  The areas can then be copied or cut and then pasted into new layers.  

The tool also can become a bounding border for "pouring" color with the paint bucket or 

gradient tools. Other marquee tools are available by clicking and holding the button. The 

marquee lets you select part of the canvas in a specific shape. By default you get a rectangular 

or perfect square if you hold down shift while selecting, but you can also select in the shape 

of a rectangle or a perfect rectangle if you hold down shift while selecting. 
 

 
 

Elliptical Marquee Tool. (M). This tool allows the user to select ellipse shaped areas 

within an image.  The areas can then be copied or cut and then pasted into new layers. The 

tool also can become a bounding border for "pouring" color with the Paint Bucket or Gradient 

tools.  Other marquee tools are available by clicking and holding the button. The marquee lets 

you select part of the canvas in a specific shape. By default you get an ellipse (or perfect circle 

if you hold down shift while selecting), but you can also select in the shape of an ellipse (or a 

perfect circle if you hold down shift while selecting). 
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Single Row Marquee Tool. Allows you to select a single row of pixels stretching. Single 

row marquee tool from one side of the image to the other. 
 

Single Column Marquee Tool. Allows you to select a single column of pixels stretching. 

Single column marquee tool from top of the image to the bottom. 
 

Lasso Tool. (L). This tool is used to select parts of a layer for editing.  There are other 

types of lassos available, including a magnetic lasso and polygonal lasso. The lasso is a free-

form selection tool that lets you drag around the canvas and select anything the lasso’s area 

covers. Within this tool you also have access to the polygonal lasso, which lets you create a 

selection by clicking around on the canvas and creating points, and the magnetic lasso, which 

works the same as the regular lasso but attempts to detect edges for you and automatically snap 

to them. 
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Polygonal Lasso Tool (L). Selects an object by drawing a straight-edge border around it. 

Click the tool button, click on the starting point on the image, drag to draw a straight-edge 

border, click and drag again to select the area of the image you wish to select. Double-click to 

finish. 
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Magnetic Lasso Tool (L). Selects an object by drawing a border that snaps to the edges 

of the defined area of the object. Click on the starting point on the image, drag around the area 

of the image. The tool will make fastening points at the edges. To finish selecting, drag the 

border to the starting point and click precisely in the point. 
 

 
 

Quick Selection Tool (W). This tool used to click like magnetic lasso tool any ware in 

the image outside the selected area. This tool will make fastening point at the edge. 
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Magic Wand Tool. (W). The Magic Wand is used to select portions of an image based 

on color.  Sections of the same color are selected when the wand it touched on the desired 

color and the mouse if left clicked. Clicking an area with the magic wand will tell Photoshop 

to select the spot you clicked on and anything around it that's similar. This tool can be used as 

a crude way to remove backgrounds from photos. 
 

 
 

Crop Tool. (C). The crop tool is used to (surprise!) crop your pictures. You can specify 

the exact size and constrain the crop tool to those proportions, or you can just crop to any size 

you please. The crop tool is an important tool for making adjustments to the overall size of an 

image.  Using the crop tool affects the size of the whole image, not just a single layer. This is 

a powerful tool and must be used carefully. 
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Perspective Crop Tool. (C). Let's see how the new perspective crop tool in Photoshop 

cc can fix this problem. You'll find the perspective crop tool nested in behind the standard crop 

tool in the tools panel. To get to it, click on the crop tool's icon and hold your mouse button 

down until a fly-out menu appears showing the other tools also available in that spot, then 

select the perspective crop tool from the list. 
 

 
 

Slice Tool. (C). The slice tool allows you to divide the image into segments which can be 

exported to form an html table. This is useful for web design because parts of the slice tool C. 

Image can be individually optimized or used as hyperlinks. Dividing such an image into 

smaller parts also makes it appear to load faster in browsers. 
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Slice Select Tool. (C). The slice select tool selects, moves, and resizes slices: in the 

toolbox, select the slice select tool and click on a slice to select it. You can move and resize 

with the slice select tool bounding box of selected slice. To move a slice by a few pixels you 

can use keyboard cursor keys. 
 

Eyedropper Tool. (I). The eye dropper is used to select color. The color that is "picked 

up" by the eye dropper appears as the new foreground color. The eyedropper tool lets you click 

on any part of the canvas and sample the color at that exact point. The eyedropper will change 

your foreground color to whatever color it sampled from the canvas. 
 

 
 

3D Eyedropper Tool (I). With the 3d material drop tool, option-click (pc: alt-click) 

a material to load it and then click anywhere to drop it to another part of your model, 

another 3d mesh, or another 3d layer. Use the 3d select material tool to help target the 

right materials indicated by the material picker thumbnail in the 3d panel. 
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Color Sampler Tool. (I). Selects color information from a specified point in your image. 

You can store up to four different colors. These can be cleared using the options bar. 
 

Ruler Tool. (I). Used to measure areas on the screen. Values appear in the options bar. 
 

Note Tool. (I). Serves as a comment feature. Usually used for electronic text edits. Select 

the tool, click on the spot on the page where you wish to make a comment. Type in the text 

box. 
 

123 Count Tool. (I). The count tool is only found in the extended version of Photoshop. 

Its main use is in areas such as scientific and medical imaging, where it is useful for recording 

the number of items that appear in a particular image. For example, in the Figure 1 example, I 

selected the count tool and clicked on all the red/brown pebbles in the picture to count how 

many there were. 
 

 
 

Spot Healing Brush Tool. (J). The spot healing brush is the default healing tool in 

Photoshop and can be used to clone areas from an image and blend the pixels from the sampled 

area seamlessly with the target area. The basic principle is that the texture from the sample 

area is blended with the color and luminosity surrounding wherever you paint. 
 

Healing Brush Tool. (J). This is an especially helpful tool that is new starting in 

Photoshop. It is used to remove dust marks and scratches from photographs.  The patch tool is 

found at the same position on the tool bar, but is used to repair areas of a photograph that are 

larger than the typical scratch. The healing brush lets you sample part of the photograph and 

use it to paint over another part. Once you're finished, Photoshop will examine surrounding 

areas and try to blend what you painted in with the rest of the picture.  You establish a sample 
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point by option/alt-clicking on the portion of the image you wish to sample from. Release the 

option/alt key and move the cursor over to the point where you want to clone to and click or 

drag with the mouse to carry out the healing brush retouching. 
 

 
 

Patch Tool. (J). This is another image retouching tool which allows you to patch areas of 

the image. There are three ways to do this. First, click on the patch tool and select an area of 

the screen that is to be patched up. Click on source in the options bar. Drag the selected area 

to the region of the image you want to use as the patch. Clicking on destination in the option 

bar enables you to do the reverse: select the patch, then drag it to the area you wish to patch 

up. Using the options bar, you may also patch up the selected area with a pattern. 
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Content Aware Move Tool. (J). Learn how to select part of an image and move it. Then 

watch as Photoshop automatically fills in the hole with matching elements from the existing 

background. In the toolbar, hold down the spot healing brush and select the content-aware 

move tool. Use the move mode to place selected objects at a different location. 
 

 
 

Red Eye Tool. (J). To access the tool, go to the healing brush toolbar area, right-click or 

hold-click for the context menu, and go to the very bottom. Once you've selected the tool, you 

do have the option to change the darkness setting and pupil size at the top of the workspace. 
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Brush Tool. (B). The paintbrush is a tool that emulates a paintbrush and the pencil is a 

tool that emulates a pencil. The paintbrush, however, can be set to many different kinds of 

brushes. You can paint with standard paintbrush and airbrush styles or even paint with leaves 

and other shapes as well. 
 

 
 

Pencil Tool. (B). The pencil tool is much like a conventional pencil, except you can 

choose a whole range of shapes and sizes for the nib using the options bar. You can also set 

the opacity of the pencil. 
 

Color Replacement Tool. (B). Photoshop's color replacement tool is not the most 

professional way to change colors in an image, and it won't always give you the results you 

need. But it usually works well for simple tasks and is such an easy tool to use that it's worth 

giving it a try before moving on to more advanced and time consuming methods. 
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Mixer Brush Tool. (B). The mixer brush tool has two wells: a reservoir and a pickup. 

The reservoir well color is defined by the current foreground color swatch in the tools panel 

or by option/alt-clicking in the image canvas area. This is the color you see displayed in the 

load preview swatch. The pickup well is one that has paint flowing into it and continuously 

mixes the colors of where you paint with the color that’s contained in the reservoir well. 

Clicking on ‘clean brush’ from the ‘current brush load’ options immediately cleans the brush 

and clears the current color, while clicking ‘load brush’ fills with the current foreground color 

again. 
 

Clone Stamp Tool. (S). The clone tool is used to copy portions of a layer from one area 

to another. It is similar to the rubber stamp tool found in earlier versions of Photoshop. Like 

the healing brush, the clone stamp lets you sample part of the photograph and use it to paint 

over another part. With the clone stamp, however, that's it. Photoshop doesn't do anything 

beyond painting one area over a new area. To use the clone stamp tool, hold down option/alt 

key and click to select a source point to clone from. Release the option/alt key and move the 

cursor over to the point that you wish to clone to, and click or drag with the mouse. 
 

 
 

Pattern Stamp Tool. (S). The pattern stamp tool allows you paint a pattern on the canvas. 

You can specify the sort of pattern you would like using the options bar. 
 

History Brush Tool. (Y). The history brush lets you paint back in time. Photoshop keeps 

track of all the moves you make (well, 50 by default) and the history brush lets you paint the 

past back into the current photo. Say you brightened up the entire photo but you wanted to 

make a certain area look like it did before you brightened it, you can take the history brush and 

paint that area to bring back the previous darkness. 
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Art History Brush Tool. (Y). The art history brush allows you to transform conventional 

images into works of art. Experiment by choosing different styles and brush types. It’s best to 

work on a new layer above the original image, this will preserve the original if you make major 

mistakes. 
 

Eraser Tool. (E). The erase tool is almost identical to the paintbrush, except it erases 

instead of paints. The eraser is used to remove portions of a layer.  Its size can be adjusted so 

that it can be used very delicately or quite grossly. Allows you to erase parts of the image. 

Erased areas are replaced with the background color. 
 

 
 

Background Eraser Tool. (E). This makes the erased area transparent. The background 

eraser is, without a doubt, one of the best tools in Photoshop for removing unwanted areas of 

a photo, but it’s not perfect and it does have one serious drawback. As an eraser tool, it 

physically deletes pixels from the image, which means that once they’re gone, they’re gone 

for good. To avoid damaging your original image, it’s a good idea to duplicate your 

background layer first before erasing any pixels, or work on a separate copy of your image. 
  

Magic Eraser Tool. (E). Much like the magic wand tool, effective for removing areas of 

similar color. Check ‘contagious’ in the options bar to ensure the area you remove is smooth. 

The magic eraser, magic wand and paint bucket tools all have contiguous selection modes. A 

contiguous selection is one based on just those neighboring, connecting pixels which fall 

within the specified tolerance that surround the point where you clicked and which have a 

similar color value. 
 

Gradient Tool. (G). The gradient tool will, by default, create a gradient that blends the 

foreground and background tool though you can load and create preset gradients as well, some 

of which use than two colors. 
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Paint Bucket Tool. (G). This tool is used to "pour" areas of color onto a layer. It is 

especially useful when used with a marquee. The gradient tool is found in the same location. 

The paint can tool lets you fill in a specific area with the current foreground color. 
 

3D Material Drop Tool. (G). With the 3d material drop tool, option-click (pc: alt-click) 

a material to load it and then click anywhere to drop it to another part of your model, 

another 3d mesh, or another 3d layer. Use the 3d select material tool to help target the 

right materials indicated by the material picker thumbnail in the 3d panel. 
 

 

Blur Tool. The blur tool is used to selectively blur areas of a layer.  The amount of blur 

can be controlled.  It is especially handy when blending colors or objects. All three of these 

tools act like paintbrushes, but each has a different impact on your picture. The blur tool will 

blur the area where you paint. 
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Sharpen Tool. Use this tool to sharp the image. You can sharpen your entire image or 

just a portion using a selection or mask. Because the unsharp mask and smart sharpen filters 

can be applied to only one layer at a time, you might need to merge layers or flatten your file 

to sharpen all image layers in a multilayered file. 
 

Smudge Tool. The smudge tool will smudge the area all around the canvas. The smudge 

tool is very useful in drawing for creating nicely blended colors or for creating wisps and 

smoke that you can add to your photos. 
 

Dodge Tool. (O). The dodge tool can make them lighter. Use the dodge tool to lighten 

parts of the image, you can choose to lighten shadows, highlights or midtone using the options 

bar. You can also set the exposure of the dodge tool. 
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Burn Tool. (O). The burn, tools are paintbrush-like tools that manipulate light and color 

intensity. The burn tool can make areas in your photo darker. The burn tool darkens parts of 

the image. Like the dodge tool, you can choose to darken shadows, highlights or midtone using 

the options bar. You can also set the exposure of the burn tool. 
 

 
 

Sponge Tool. (O). The sponge tool can saturate or desaturation color in the area you paint 

with it. These are all very useful tools for photo touch ups. You can use the sponge tool to 

paint in localized adjustments that will modify the saturation of an image. The sponge tool has 

two modes: Saturate increases the color saturation, while desaturate decreases the color 

saturation. 
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Pen Tool. (P). The pen tool is used for drawing vector graphics. It can also be used to 

create paths that can be used for various things. The pen tool is used to create paths, which can 

be made into selections or objects that can have a stroke around the outside or be filled with 

color (like triangles, rectangles and other shapes). 
 

 
 

Freeform Pen Tool. (P). The Freeform Pen Tool allows you to create freehand paths. 

Add Anchor Point Tool. The Freeform Pen Tool allows you to create additional anchor 

points on a path, essentially giving you the ability to manipulate it in very flexible ways. 
 

Delete Anchor Point Tool. Allows you to change paths by deleting anchor points. 

Convert Point Tool. Another tool for manipulating anchor points of a path. 

Horizontal Type Tool (T). This is the tool that is used to add to an image and to edit 

existing text. Size, color, and other attributes of the text can be specified and adjusted. The 

type tool lets you type horizontally. Tools hidden beneath the horizontal type tool will let you 

type vertically and also create horizontal and vertical text masks. 
 

Vertical Type Tool (T). Creates vertical type, you can adjust the size and font in the 

options bar. 
 

Vertical Type Mask Tool (T). This creates a horizontal text shaped selection which can 

be manipulated in various ways. 

Horizontal Type Mask Tool (T). This creates a horizontal text shaped selection which 

can be manipulated in various ways. 

http://en.wikipedia.org/wiki/Vector_graphics
http://www.digitalscrapbookplace.com/university/tutorials/ps_layermasks.shtml
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Path Selection Tool (A). The path tool lets you move any created paths around. It's like 

the move tool, but for paths. This line allows you to select vector graphics (the sorts of lines 

and shapes you can draw with the Pen Tools in Photoshop). 
 

Direct Selection Tool (A). This allows you to manipulate vector graphics such as lines, 

shapes and text. 
 

Rectangle Tool (U). The shape tool lets you create vector rectangles, rounded rectangles, 

circles, polygons, lines, and custom shapes. These tools are very useful when designing or 

when creating shape masks for photos. 
 

Round Rectangle Tool (U). Draws rounded rectangular paths. 
 

Ellipse Tool (U). Draws ellipses. 

Polygonal Tool (U). Draws polygons.   

Line Tool (U). Draws lines. 

Custom Shape Tool (U). Draws custom shapes. To choose a different shape, click on the 

preview thumbnail. This will open the Shape Picker which displays all of the shapes we 

currently have to choose from. Photoshop actually comes with many more shapes than the 

limited number we're presented with at first. We'll see how to load in the other shapes in a 

moment. 
 

 
 

Hand Tool (H). The hand tool allows you to click and drag around the Photoshop canvas. 

If the entire canvas currently fits on the screen, this tool won't do anything. This tool is for 

easily navigating around when you're zoomed in, or a picture is simple too big to fit on the 

screen at 100%. It is use to apply allows you to move around within the image. Select the tool, 

click on the spot on the page, and hold the mouse button down, drag to move in the area. 
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 Rotate View Tool (R). To use the rotate view tool, select it from the tools panel and 

click and drag in a window to rotate the image around the center axis. As you do this, you will 

see a compass overlay that indicates the image position relative to the default view angle 

(indicated in red), which can be useful when you are zoomed in close on an image. If you hit 

Esc or click on the Reset View button in the Options bar, this resets the view angle to normal 

again. 
 

Zoom Tool (Z). This is a very handy tool used to quickly zoom in or out of an image. The 

zoom tool lets you zoom in and out of the Photoshop canvas by clicking on a given area. By 

default, the zoom tool only zooms in. To zoom out, hold down the option key and use the 

zoom tool as you normally would. Select the tool, choose zoom in or zoom out in the         

Options bar, click on the area of the image you wish to magnify or reduce. 
 

Edit Toolbar. Either way opens Photoshop’s new customize toolbar dialog box. The 

dialog box is made up of two main columns. The column on the left is the toolbar column. It 

shows us the current toolbar layout, including the order in which the tools appear and their 

groupings. The column on the right is the extra tools column. It's where we drag tools from 

the toolbar that we want to remove. 
 

Set Foreground & Background Color (Alt+Backspace+Ctrl+ Backspace). These tools 

let you manage the colors you're using. The color on top is the foreground color and the color 

in back is the background color. The foreground color is what your brushes will use. The 

background color is what will be used if you delete something from the background or extend 

it (although now, Photoshop CC will give you the option for using your foreground color 

instead in some circumstances). The two smaller icons up top are shortcut functions. The left 

one, showing a black square on a white square, will set your foreground and background colors 

to the defaults (Keyboard: D). The double-headed curved arrow will swap your foreground 

and background color (Keyboard: X). Clicking on either the foreground or background color 

will bring up a color picker so you can set them to precisely the color you want. 
 

Edit In Quick Mask Mode (Q). To use quick mask mode to create and edit selections 

quickly, start with a selection and then add to or subtract from it to make the mask. You can 

also create the mask entirely in quick mask mode. Color differentiates the protected and 

unprotected areas. When you leave quick mask mode, the unprotected areas become a 

selection. 
 

Change Screen Mode (F). There are three screen modes that you can select from: 

standard screen mode; full screen mode with menu bar and full screen mode. When you select 

a screen mode it will be applied to all open images. The standard screen display mode displays 

images in their document windows. In this mode, more than one document can be seen at a 

time and it is easy to select individual images just by clicking on their windows.  

Chapter-3. File Menu. (Alt+F). 



Vinod Computer Institute Mehnagar Azamgarh UP. 

--------------------------------------------------------------------------------------- 

30 | P a g e  
 

 
 

New (Ctrl+N). This option is used to create a new Photoshop document or file with PSD 

extension. Whenever this option is selected, there is opened a window or dialogue box 

named new. In that dialogue box or window there are found many options through which one 

can specify the size, resolution, color mode and content for the new document. 
 

 
 

Size. If you type any values in the boxes named width and height given in the dialogue box 

named new, you will notice that the option named custom will get selected all by itself out of 

the options given in the drop down menu named preset sizes. 
 

Resolution. This box is used to specify the resolution of the image (PSD file that is about to 

be created). Generally, resolution equal to 72px/inch is considered to be ok for the images 

which are made for the use in websites and presentations. If you want to print an image for 

any professional purpose, the suitable resolution cannot be less than 300px/inch but in order 

to print an image for an ordinary purpose, resolution equal to 240px/inch might be proved 

perfectly ok. 
 

Color Mode. Right beneath the box under the head or resolution, there can be seen a drop-

down menu named mode. This drop-down menu offers usually five options regarding the 

selection of color mode for the document. These options are. RGB, CMYK, grayscale, lab 

color mode. 
 

Open (Ctrl+O). This drop-down menu is used to select the current location of the required 

image file in the computer’s hard drive or in any external drive (CD, DVD or USB etc.). 
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whenever any location is selected through this drop down-menu, all the folders and files 

located there appear in an instant in the same window right beneath the menu named look in. 

but in the window named open, that drop-down menu is not the only source to look for a file. 
 

  
 

Browse In Bridge (Ctrl+Alt+O). Browse is the third option that is given in the file menu. 

This is an alternative option for searching and opening required image files in Photoshop. 

Whenever this option is selected, there is appeared a window named file browse on the right 

side of the main Photoshop window. Through this window we can not only search and open 

our required image files but at the same time, the same file browser tells us all the main 

properties of the selected file.  
 

Open As Smart Object. Let’s you open a file as a linked smart object in a new Photoshop 

document. 
 

Open Recent. This option helps to look for recently modified files for further modification. 

Whenever you put the pointer of your mouse on Open Recent in the File Menu, there is opened 

a side menu that shows the 10 most recently modified files, out of those you can select and 

open your required file by clicking on it. 
  

Share My Screen. This command is used to allow share the screen with another user over the 

internet. 
 

Device Central. This command is used to look preview your document will appear on a 

particular mobile phone. 
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Close (Ctrl+W). This option is used to close an open document in Photoshop. This option is 

very rarely used by Photoshop users. 
 

Close All (Ctrl+Alt+W). This command is used to close all the current open file. 
 

Save (Ctrl+S). This command is used to saves the current document to your hard drive. If 

you’ve already saved the document, choosing this command overwrites the previous 

version. If you haven't saved the document before, choosing this command opens the save 

as dialog box. 
 

 
 

Save As (Ctrl+Shift+S). This command is used to opens the save as dialog box where you 

can save a copy of the current file with a new name or in a different format. Saves the current 

document to your hard drive. If you’ve already saved the document, choosing this command 

overwrites the previous version. (You’ve been warned!) If you haven’t saved the document 

before, choosing this command opens the save as dialog box, explained next. 
 

Check In. Previous versions of the program included a little application called version cue, 

which was useful if you worked and exchanged files with other folks using adobe’s creative 

suite. It kept track of the changes each person made to each file (technically called asset 

management), and acted like a librarian, letting you check out files when you needed to 

work on them. It also organized documents and recorded other important bits of information 

about the files you use. 
 

Save For Web & Device (Ctrl+Alt+Shift+S). This command is used to allow save the 

current file as a web browser. Let’s you save a copy of the current document in formats that 

work well with web Browsers and devices like smart phones. 
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Revert (F12). This command is used to restore recent last time save file. Your last saved work. 

Wipes out any changes you’ve made to the current document and returns it to its last saved 

state. 
 

Place. Used this option to place an image or other Photoshop-supported file format as a Smart 

Object into your current document. The artwork appears on its own layer, surrounded by a 

bounding box you can use to resize it. 
 

Import. When you choose this menu item, Photoshop opens another menu containing options. 

For using a scanner to get a picture, drawing, or anything else off paper and into Photoshop (for 

more on scanning). Make sure you’ve installed the scanner’s software so Photoshop can 

communicate with it (if you haven’t installed the software, you won’t see it in the submenu). 

Here are the items in the import submenu. 
 

Variable. Data Sets let you import files that are filled with info Photoshop needs to make 

customized images based on a template file. 
 

Video Frames to Layers. Let’s you open a movie file’s frames as individual layers in a new 

document. 
 

Notes. Let’s you import annotations into your image from PDF documents. 
 

Export. Choose this menu item to export your image as paths so you can open them with Adobe 

Illustrator, export collected data (Photoshop CC Extended only), or export a sequence of images 

to video. 
 

 

 

Automat. As you can automate the tasks you do over and over in Photoshop by saving them as 

actions. This menu item lists the built-in actions that come with Photoshop. 
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Scripts. Scripts go hand in hand with Automation because they also handle repetitive or complex 

tasks for you. Photoshop’s built-in scripts like the super handy Image Processor are listed here. 
 

File Info. Choose this item to see info (Expert Academy) about the current document, including 

when it was created, how big the image is, its name, copyright information, and so on. You can 

add and edit these details, too. 
 

Page Setup (Ctrl+Shift+P). This command is used to set the Size, Source and Orientation for 

the page. 
 

Print (Ctrl+P). Selecting this item opens the humongous Print dialog box and lets you choose 

things like the number of copies, print quality, and which printer you want to use. After you get 

the settings just right, click Print to send your document to the printer. 
 

 

 

Print One Copy. Choose this option to make Photoshop send the current document to the 

printer you normally use without giving you a chance to change any settings first. Think of Print 

One Copy as a quick-and-dirty way to print an image without encountering a slew of dialog 

boxes. 
 

Exit (Ctrl+Q). This command is used to close opened Photoshop window. 
 

Chapter-4. Edit Menu. (Alt+E). 
 

 
 

Undo (Ctrl+Z). This command is used to delete the impact of the most recently applied 

command on the Photoshop document. In order to understand the functionality of the 

command named Undo. As soon as that command will be selected, impact of the recently 

applied command for complete selection will be removed and the image will get 

deselected. 
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Step Forward (Ctrl+Shift+Z). This command is used to apply back the removed impacts of 

the two or more than two commands on Photoshop document. For instance, you have applied 

four different commands on the Photoshop document and then because of some reason, 

removed the impacts of the two most recently applied commands by selecting the command 

named Undo either by clicking on it in the Edit Menu or by hitting CTRL + ALT + Z on the 

keyboard. Then, somehow you changed your mind wanted back the removed impacts of the 

applied commands on the document, all you need to do is the select the command named Step 

Forward twice. When you select that command very first time, the most recently deleted 

impact will be restored  first and when you select the same command second time, the impacts 

of the command will be restored that has been deleted before the first one. 
 

Step Backward (Ctrl+Alt+Z). This Command is used to undo or remove the impacts of the 

two or more than two recently applied commands from the Photoshop document one by 

one. For instance, if you have applied four different commands on your document and you 

want remove the impacts of the fourth one and the third one you can select the option 

named Step Backward twice to get rid of the impacts of those two most recently 

applied  commands. On the other hand, if you want to delete the impacts of the three most 

recently applied commands, you are supposed to select the option named Step 

Backward three times.  
 

Fade. This command can only be applied right after the use of any Tool, Adjustment or Filter. 

The main purpose of this command is to reduce the opacity of the most recently applied tool 

(e.g. Brush Tool, Eraser Tool, Pencil Tool, Blur Tool, Shape Tool, Sponge Tool etc.). This 

command lets you change the strength (opacity) and blend mode of the last image edit you 

made. It works on filters, image adjustments, and so on. 
 

Cut (Ctrl+X). Through this command we can transfer any selected image or a selected part 

of an image temporarily from the canvas to computer’s memory (clip board).  Whenever we 

use this command, selected image or the selected part of an image vanishes from its place and 

appears only when we use another command named paste given in the same menu. 
 

Copy (Ctrl+C). Through this command we can create a copy of a selected image or the 

selected part of an image temporarily into computer’s memory in an area that is called clip 

board. By using paste command we can have that copy on some other document or on any 

other layer of the same document. In this case the original image remains intact on its first 

place. 
 

Copy Merged (Ctrl+Shift+V). This option is used to this command makes a merged copy of 

all the visible layers in a selected area. If you're editing a multi-layered document, this is a 

handy way to quickly consolidate and copy a certain part of the image—the area you've 

selected—onto a single layer without having to select that area on each layer. 
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Paste (Ctrl+V). This command is used to places objects you’ve copied to your computer's 

memory into the current document. 
 

Paste Info (Ctrl+Shift+V). This command is used to drop and display images that we have 

saved in the Clipboard by applying the command named Copy on the separate layer of the 

same document with layer mask beside. By filling white, black and grey colors inside the 

layer mask you can manipulate the transparency of layer beside the mask. 
 

Paste Special. This menu item was renamed in Photoshop cs5 (it used to be called paste into) 

And gives you a few different options, including pasting one selection into another (By 

selecting paste into). For example, if you copy a selection (an image, say) and then create a 

selection in another document (such as a picture frame), you can use this command to make 

Photoshop paste the contents of that first selection into the Second one, complete with a layer 

mask. 
 

Clear. In Adobe Photoshop CC the command named clear is used to delete the selected part 

of the layer that is currently selected in the layer palette.  
 

Check Spelling. Through this command you can correct the spelling mistakes made 

accidentally in the text, typed on the Photoshop document. 
 

Find And Replace Text. If you have used any specific word many times in the text typed on 

Photoshop document and you want to replace that word with some other word in an instant, 

you can use the option named find and replace text given in the edit menu. 
 

Fill (Shift+F5). This command is used to fill any desired solid color or predefined pattern 

inside the selected layer with desired level of opacity. Further through this command you can 

apply different blending modes on the selected solid color or pattern, filled inside the selected 

layer. In case you don’t want to fill color or pattern inside the entire layer, but inside the 

selected part of the layer only, you can do so by preserving the transparency of the part of the 

layer that is not selected at the current time by putting check inside the check box 

named preserve transparency given in the dialogue box named fill. 
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Stork. This option is used to create outline around the selected area. Through this option you 

can not only create outline around the selected area, but you can set 

the Width, Color, Location, Blending Mode and Opacity for that outline. Further through this 

option you can decide whether the transparency of the selected layer should be preserved or 

not. 
 

 
 

Content-Aware Scale. This feature lets you change the size of an image without distorting 

the important parts. 
 

Puppet Warp.  This command lets you twist and turn, move and distort pixels independently 

of other pixels in an image. By placing markers (called pins) on the object you want to move, 

Photoshop creates a mesh behind it that you can move the object along. It's discussed in step-

by-step. 
 

Free Transform (Ctrl+T). Through this command you can easily re-size any selected layer 

and rotate it in any direction. Further, while composing with Photoshop, you can skew a 

completely straight sided object or you can make a completely different object out of it by 

distorting its initial features. Moreover, after putting any layer in the state of free 

transformation, you can widen or shorten its upper, lower, right and left sides to give more 

natural look to an object drawn on the same layer. 
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Transform. Like free transform, transform is also used to re-size, rotate, skew and distort any 

object but the difference is that transform provides separate commands to perform all the tasks 

described above and there is left no need to use shortcut keys in case you are not comfortable 

with them. Whenever you put the pointer of your mouse on the option named transform given 

in the edit menu there is appeared another menu containing 11 more options. 
 

 

 

Again (Ctrl+Shift+T). This command is used to apply previously applied transformations one 

more time generally on the duplicate layer. 
 

Scale.  This command is used to re-size any selected layer. 
 

Rotate. This command is used to rotate any selected layer in any required direction. 
 

Skew. This command is used to make skew any straight sided shape. 
 

Distort. Through this command you can distort the initial features of the shape made on the 

selected layer and convert it into a totally different shape. 
 

Perspective. Through this command you can widen or shorten any side of the selected layer 

that is how you can give a natural look to the image on the same layer. 
 

Flip Vertical. This command is used to convert the top of the selected layer into the bottom 

of it and bottom of the selected layer into its top. 
 

Flip Horizontal. This command is used to convert the left side of the selected layer into the 

right side and right side of the selected layer into the left side. 
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Auto-Align Layers. This command makes it easy to create panoramas from a group of similar 

images. When you run it, Photoshop looks for the common elements in each photo and aligns 

them automatically. 
 

Auto Blend Layers. This option lets you combine the best parts of similar images into a single 

image; Photoshop creates all the necessary layer masks for you.  
 

Define Brush Preset. This option is used to choose convert the selected object into a custom 

brush. 
 

Define Pattern. This option is used to makes a custom pattern out of your current selection. 
 

 

Define Custom Shape. This command is used to add drawings made by the use of pen tool as 

new shapes inside the custom shapes menu. 
 

Purge. This command is used to make Photoshop run faster by deleting unnecessary or corrupt 

files holding the record of previously applied commands on Photoshop document from the 

computer's memory. There can be seen four different commands in the side menu 

of purge through which you can get rid of all the corrupt or unnecessary files. 
 

Undo. Through this command you can delete all the files holding the record of the command 

named undo. 
 

Clipboard. By selecting the option named clipboard given in the side menu of purge you can 

delete all the files holding the record of the commands named cut, copy, paste and copy 

merged. 
 

Histories. By selecting the option named histories given in the side menu of purge, you can 

delete the record of all the variations made on the currently opened document. That record can 

be seen in the history palette. 
 

Adobe PDF Presets. This item lets you manage, edit, and add groups of settings you can use 

when making pdf versions of images. And working with documents in pdf format. 
 

Presets Manager. You can manage groups of custom brushes, patterns, shapes, colors, and 

styles by Selecting this menu item, which lets you edit or combine groups into new libraries 

and delete groups. Has the scoop on using the preset manager.  
 

Color Setting (Ctrl+Shift+K). Through this command you can change the color setting for 

your document. As soon as you select this command given in the edit menu, a dialogue box 

named color setting appears. In that dialogue box there are supposed to be found many options 

for color setting and there is one remarkably cool thing about that dialogue box that it has a 

description pan right below the rest of the options and through that description pan Photoshop 

describes each item given in that dialogue box briefly whenever you put the pointer of your 

mouse on it. 
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Assign Profile.  This option is part of Photoshop’s color-management system. From here, you 

can assign specific color profiles to individual documents or disable color management. 
 

Convert To Profile.  This option lets you change an image's color-management profile. 
 

Keyboard Shortcuts (Alt+Shift+Ctrl+K). Choose this item to customize Photoshop’s 

keyboard shortcuts, add your own, and save your personalized menu commands to share with 

other folks. 
 

 
 

Menus (Alt+Shift+Ctrl+M). Using this command, we can choose this option to see all of 

Photoshop’s menus and, if you like, visible them. 
 

Preferences. (Ctrl+K). This command is used to set the general setting, unit & rulers. 
 

Chapter-5. Image Menu. (Alt+I). 
 

 
 

Mode. This is where you change the current document’s color mode and bit depth. You can 

choose from Bitmap, Grayscale, Duotone, Indexed Color, RGB, CMYK, Lab, and 

Multichannel color modes and 8-, 16-, and 32-bit images. 
 

Adjustment. Curves (Ctrl+M). This command is used to you can change the colors and 

overall tonal quality of your image. Has the full scoop on correcting images without harming 

your original? Different mode. Curves, color balance, variation etc. 
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Auto Tune. This command is used to analyze the current image and tries to adjust its overall 

colors to make it look better. 
 

Auto Contrast. This command adjusts the contrast between light and dark areas in your 

images so that highlights look brighter and shadows look darker.  
 

Auto Color. By using this artificial lighting can skew the colors in images, so use this 

command to shift them back so they look more natural.  
 

Image Size. This command is used to you change your image's resolution and dimensions. 

This dialog box is discussed at length. 
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Canvas Size.  This command is used to change your document's dimensions without changing 

its file size or resolution. Use this command if you need more space in a document but don't 

want to resize its content. 
 

 
 

Image Rotation.  This command is used to rotate your image and canvas. You can choose one 

of the presets—like 180° or 90° CW (clockwise)—or choose arbitrary and then enter the 

number of degrees you want to turn the image. 
 

Crop.  This command is used to you remove the edges of an image in order to produce a more 

visually pleasing composition or change its size. Photoshop keeps the area inside the crop box 

and removes everything else, leaving you with an image that's physically smaller than it was 

on cropping. 
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Trim.  This command is used to like crop; you trim away the edges of an image based on the 

color in each corner or on transparent pixels. This command is incredibly handy when you 

need to produce the smallest image possible. 
 

Reveal All. This command shows you all your image's hidden edges if you've cropped 

nondestructively. 
 

Duplicate.  Makes a copy of your current document and lets you give the duplicated document 

a new name. 
 

 
 

Apply Image. This command lets you combine a layer and channel from one document with 

a layer and channel from another document using the blend mode and opacity of your choice. 

Change image color and opacity. 
 

Calculation.  This command is used to works a lot like apply image, but instead of combining 

layers and channels, it combines only channels. Change channels color. 
 

 
 

Variables.  This menu item lets you designate areas of a document as placeholders for other 

images or text that Photoshop add automatically from a specified data source. Display total 

numbers of layer and copy images. 
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Apply Date Set. Once you've created a document template containing variables, you can 

choose this menu item to tell Photoshop where the variable data—the other images and/ or 

text—lives so it can automatically create the various versions of the document. 
 

Trap. This command lets you set the spread of objects in your images, which controls how 

much colors overlap where they intersect. This setting is important in offset printing. For an 

offset press, starting.  
 

Chapter-6. Layer Menu. (Alt+L). 
 

 
 

New Layer (Ctrl+Shift+N). This option is use to add a new layer or layer group to your image. 
 

Duplicate Layer. This option does just what its name implies. Makes a copy of the current 

layer. 
 

Delete Layer.  Choose this item when you want to delete a layer. You can do the same thing 

by activating a layer and then pressing the Delete key (Backspace on a PC). 
 

Rename Layer. This option highlights the name of the currently active layer in the layers 

panel so you can rename it. (A little known fact is that you can also press the tab key to 

highlight the name of the next layer down, or shift-tab to highlight the name of the next layer 

up.). 
 

Layer Style. This command is used to go here to set the current layer's blending options and 

apply effects like drop shadows, glows, and gradient over texture, stork. 
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Smart Filter. This command is used to this option lets you delete or disable a smart filter 

mask. scoop on using smart filters. 
 

New Fill Layer.  It is used to go here to create a layer and tell Photoshop whether if you'd like 

to fill it with a solid color, gradient, or pattern the neat thing about fill layers is that, when you 

change canvas size, Photoshop automatically fills in the extra space with the color, gradient, 

or pattern you picked. 
 

 
 

New Adjustment Layer. In this option creates a new adjustment layer so you can apply 

nondestructive changes to your images. Adjustment layers are defined. Brightness &contrast, 

color balance, curve, invert. 
 

Layer Content Option. In this option use to you could use this option to change an adjustment 

layer's settings. In cs4, just double-click the adjustment layer's thumbnail in the layer’s panel 

and the new properties panel opens, which contains those same settings. 
 

Layer Mask.  From here you can show, hide, delete, and apply layer masks, which are like 

digital masking tape. 
 

Vector Mask.  It will layer mask item above, but it lets you work with vector-based objects. 
 

Create Clipping Mask (Ctrl+Alt+G). This command is used to attach layers to one another 

so the content of one layer shows through the shape. 
 

Smart Object. This command is used to this menu item includes tools for working with smart 

objects—editing them, duplicating them. 
 

Video Layer. This command is used to add, remove, and paint video layers, you can also use 

this item's options to restore video frames, manage color, edit video and animation layers, and 

set when video layers appear in a timeline. 
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Type. This command is used to set related to text that were previously sprinkled throughout 

Photoshop’s menus and preferences. Vertical & horizontal wrap text. 
 

Rasterize. This command converts text, vector-based objects, smart objects, shapes, 3-d 

objects, and video frames into raster-based objects. 
  

New Layer Base Slice. This command is used to add slices for web layouts to the currently 

selected layer based on its content. 
 

Group Layer (Ctrl+G). This command is used to group active layers together. The layers will 

appear in their own folder in the layer’s panel. Inside any shape. 
 

 
 

Ungroup Layer (Ctrl+Shift+G). This command is used to removes layers from a group and 

deletes the group (but doesn’t delete the layers). 
 

Hide Layer. This command is used to hide layers or layer groups temporarily so you can see 

and work with objects in complex images; it's the equivalent of turning off a layer's visibility 

icon. 
 

Arrange Layer. This command is used to change the order of layers and layer groups in the 

layer’s panel. 
 

Combine Shape. This menu item lets you combine and intersect objects on Shape layers that 

you’ve drawn using Photoshop’s built-in Shape tools.  
 

Align Layer To Selection.  This command is used to this option lets you align content that 

lives on different layers. 
 

Distribute Layer.  This item aligns the contents of three or more layers along the object's 

edges or center points. 
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Lock Layer. This command lets you lock the activated layers, or lock all the layers in a group 

so you don't accidentally edit or change them. 
 

Link Layer. This option used to hook layers together so they move as if they were a single 

layer. You can still edit linked layers, and you can unlink them. 
 

Select Link Layer. This command is used to choose a linked layer and then pick this menu 

item to activate all the layers linked to it. 
 

Merge Layers (Ctrl+G).  This command is used to combines the active layers or layer groups 

into a single layer. 
 

Merge Visible (Ctrl+Shift+G). Used this command to combine all your image's visible layers 

into a single layer. 
 

 

 

Flatten Image. This command is used to merges all your image's layers into the background 

layer. 
  

Matting. This command is used to removes the extra pixels surrounding an object's edge after 

you’ve isolated it from its original background. After you apply matting, the item's edge should 

look cleaner and more natural.  
 

Chapter-7. Type Menu. (Alt+Y). 
 

 
 

Panels. This menu item gives you access to the Character Styles and Paragraph Styles panels. 
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Anti-Alias. Use this option to control how much blurring occurs on the edges of text to make 

the letterforms smoother. 
 

Orientation. This menu lets you switch between horizontal (left-to-right, perfectly legible) 

and vertical (top-to-bottom, completely unreadable) text. 
 

Open Type. This handy menu item gives you fast access to the extra formatting goodness 

contained in some open type fonts. 
 

Extrude To 3D. This command creates a new 3d object (and 3d layer) from the currently 

active type layer. To learn more about Photoshop’s 3d tools. 
 

Create Work Path. Use this command to create an editable path out of the active Type layer, 

which lets you rotate and change the shape of individual characters. 
 

Convert To Shape. This command creates a shape layer out of an active type layer. 
 

Rasterize Type Layer. This command converts a vector-based Type layer into un-editable 

pixels. 
 

Convert To Paragraph Text. This command converts point text (the kind that can dangle off 

the edge of your document) to paragraph text. 
 

Wrap Text. Use this command to summon a dialog box that lets you reshape text in a variety 

of ways. 
 

Font Preview Size. This handy command lets you change the size of font previews visible in 

the Fonts menus that live in the Options bar and Character panel. 
 

Language Options. This menu gives you access to the special features of East Asian and 

Middle Eastern languages. 
 

Update All Text Layers.  Opening a Photoshop document containing text created in an earlier 

version of the program can sometimes cause the text to reflow. This command lets you update 

all the layers in a document to the current version of the program. 
 

Replace All Missing Font. Use this command to replace all the missing fonts in a document 

with a different font.  
 

Paste Lorem Ipsum. This command pastes a chunk of placeholder text into the active type 

layer. 
 

Load Default Type Styles. New in Photoshop cc, you can use this command to load any 

character or paragraph styles that you obtained from someone else or downloaded from the 

internet,   
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Save Default Type Styles. Also new in Photoshop CC, once you’ve formatted text to your 

liking, this command lets you include save that style and include it in each new document you 

create. 
 

Chapter-8. Select Menu. (Alt+S). 
 

 
 

Select All (Ctrl+A).  This command is used to places marching ants around the perimeter of 

your document and grabs everything on the currently active layer. 
 

 

Deselect (Ctrl+D). This command is use to get rid of the marching ants and deactivate a 

selection. 
 

Reselect (Ctrl+Shift+D). If you didn’t mean to get rid of a selection, use this command to 

reactivate the last selection you created. 
 

Inverse (Ctrl+Shift+I). This command is used to you select an area and want to flip-flop the 

selection to select the part that's not selected. 
 

All Layers (Ctrl+Alt+A). This command is used to activate all the visible layers in the layer’s 

panel so you select all layer one at a time. 
 

Deselected Layers. This command is used to deactivate the currently active layers. 
 

Find Layers (Alt+Shift+Ctrl+F). This menu item activates the row of layer filtering options 

at the top of the Layers panel. 
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Isolated Layers. New in Photoshop CC, this command automatically filters your Layers panel 

so that you see only the currently active layers. 
 

Color Range. This command is used to open a dialog box that lets you select areas in your 

image based select on color. 
 

Similar Layers. This command is used to finds all the pixels in your image that match the 

selected area's colors, but it finds similar-colored pixels anywhere in your image. 
 

Refine Adage (Ctrl+Alt+R). This command is used to opens a dialog box that lets you fine-

tune the edges of a selection, which is especially helpful when wispy bits like hair or fur are 

involved. 

 

Modify. This command is used to your current selection by expanding or shrinking it, 

feathering it, grabbing just its border, or smoothing it. 
 

 

 

Grow. This command is used to finds and grabs pixels that match the colors around the area 

you've selected. The pixels have to be adjacent to your selection. 
 

Similar. This command is used to finds all the pixels in your image that match the selected 

area's colors, but it finds similar-colored pixels anywhere in your image. 
 

Transform Selection. This command is used to resize the currently selected area with a 

bounding box just like free transform. 
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Edit Quick Mask Mode. This command is used to temporarily cover your image with a red 

overlay, or mask, letting you create or fine-tune a selection visually. 
 

Load Selection. This command is used to activate a selection you previously saved so you can 

use it again. 
  

Save Selection. This command is used to save a selection for future use. 
 

Chapter-9. Filter Menu. (Alt+T). 
 

 
 

Last Filter (Ctrl+Alt+F). This command applies the last filter you used with the same settings 

to the currently active layer, smart object, or layer mask. 
 

Convert For Small Filter. This command is used to convert a regular layer to a smart object 

so you can use smart filters. 
 

Filter Gallery. Choose this option to see a preview of how your image will look if you apply 

various filters. It’s available for several filter categories, and it’s a good way to learn how those 

filters affect your image.  
 

Adaptive Wide Angle. This filter lets you easily fix distortion problems common when 

shooting with a wide-angle or fish-eye lens. 
 

Camera Raw Filter. New in Photoshop CC, this command lets you open the Adobe Camera 

Raw plug-in as a filter inside Photoshop. 
 

Lens Correction. Not only does this filter let you add a beautifully darkened edge vignette it 

can also correct all manner of lens distortion. 
 

Liquefy. This command is use to push, pull, and move pixels in all sorts of ways in order to 

change reality. 
 

Oil Paint. As you might guess, this filter lets you create a painting from a photo by tweaking 

a series of sliders. 
 

Vanishing Point. This command is used to maintain an image's perspective while you paint, 

clone, or add other images to it. 
 

Artistic. This command is used to filters that make images look like a painting or drawing. 
 

Blur – Motion Blur. This command is used to change the focus in all or part of an image this 

menu gives you access to the three new filters—field blur, iris blur, and tilt-shift—that are 

useful for creating shallow-depth-of-field effects after you take the photo. Change blur radius 

and quality low, medium, high. 
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Brush Stroke. The filters in this category make your image look like it was painted, penciled, 

or spray-painted, among other effects. 
 

Distort – Swirl. This command is used to filters create geometric patterns based on your 

image, including ripple, twirl, and zigzag effects. 
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Noise – Add Noise. This command is used to this category includes filters that can help smooth 

areas of an image that don't blend well, fix dust and scratches in photos, and remove graininess 

you can also use these filters to add grain to give an image more texture and depth. 
 

 

 

Pixelate. These filters convert images or selections into groups of geometric shapes and 

patterns. 
 

 
 

Render (Lens Flare). These filters let you add cloud patterns, fiber patterns, and lens flares, 

and adjust an image's lighting. 
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Sharpen. This command is used to filters in this category to make blurry or out-of-focus 

images clearer. 
 

Sketch. This command is used to you add artistic effects to make images look like they were 

hand drawn with charcoal, conte crayons, graphic pens. 
 

Stylize (Tiles). This command is used to accentuate the edges in an image in order to do things 

like turn images into collections of blocks or dots, a pencil sketch, or add a wind-blown look. 

You can use the emboss filter in this category to sharpen a blurry image. 
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Texture. This command is used to make an image look like it's on a textured surface such as 

tiles or stained glass. 
 

Video. This command is used to your smooth images that you’ve grabbed from videos, and 

restrict images to colors that display properly on TV in the United States (NTSC-safe colors). 
 

Other (Maximum). This command is used to catch-all category includes options that let you 

build your own custom filters and adjust a layer mask's size, among other things. 
 

 

 

Digimarc. These filters let you add a watermark and copyright info to images. 
 

Browse Filter Online. This command is used to fires up your web browser and takes you to 

the adobe website so you can browse and download even more filters. 
 

Chapter-10. 3D Menu (Alt+D). 
 

 
 

New 3D Layer From File. Creates a new 3D layer in the currently open document from 

another document that you navigate to on your hard drive. 
 

Export 3D Layer. Choose this command to export the contents of the currently active layer 

to a variety of formats for use with other programs. 
 

New 3D Extrusion From Selected Layer. Creates a new 3D layer from the contents of the 

currently active layer. 
 

New 3D Extrusion From Selected Path. As you might suspect, this command creates a new 

3D layer from the currently active path. 
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New 3D Extrusion From Current Selection. This command creates a new 3D layer from the 

currently selected objected (denoted by marching ants). 
 

New Mesh From Layer. Creates a wire-frame mesh from the currently active layer comprised 

of thousands of polygons, which lets you manipulate the layer’s contents in 3D space. 
 

 

 

New 3D Postcard From Layer. This command is used to apply 2-d layers to 3d planes that 

Photoshop calls postcards. Postcards can be used inside other 3d objects. 
 

Add Constraint From. Choose this command to create a constraint—usually a hole or shape 

you want to extrude from the 3D object—from a selection (marching ants) or the currently 

active path. 
 

New Shape From Layer. This command is used to you wrap a 2-d image around a 3d shape. 

Photoshop cc extended comes with a bunch of built-in shapes, including cones, spheres, and 

donuts. 
 

Show/Hide Polygons. Let’s you see the thousands of individual polygons that comprise the 

wire-frame mesh. 
 

Move Object To Ground Pane. This command snaps the object to the ground plane. 
 

Split Extrusion. Splits a 3D object into individual meshes that you can then manipulate 

individually (similar to how a jigsaw puzzle is split into separate pieces). 
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Merge 3D Layers. Combines the currently active 3D layers into a single layer. 
 

New Tiled Painting From Layer. Choose this command to create a seamless tiled pattern 

from the currently active layer. 
 

Paint Falloff. You can used this option to control the amount of paint Photoshop applies to a 

surface as it curves away from you. 
 

Paint On Target Texture. Let’s you choose the specific texture (you have eight to pick from) 

onto which you want to apply paint. 
 

Generate UVS. Choose this command to prompt Photoshop to regenerate any edges or facets 

of your 3D object, which is helpful when you’re trying to paint across an object that has seams 

(like a soccer ball, say). 
 

Create Painting Overlay. Let’s you control how texture is applied or mapped onto to your 

3D object. 
 

Select Paintable Area. This command automatically selects areas of the 3D mesh onto which 

you can successfully apply paint. 
 

Paint System. Let’s you switch between Photoshop’s Texture and Projection systems for 

applying paint to a 3D object. 
 

Make Work Path From 3D Layer. This command creates a path from the currently active 

3D layer. 
 

Sketch With Current Brush. This option lets you experiment with custom brush settings to 

create a texture file that you can apply to the 3D object’s mesh. 
 

Render. Creates a full-resolution, high-quality version of the 3D scene you’ve created. 
 

Get More Content. Transports you to the 3D section of Photoshop.com where you can 

download models, materials, meshes, and so on for use in your projects. 
 

Chapter-11. View Menu (Alt+V). 
 

 
 

Proof Setup. This command is used to create a proof (a sample version of your image that 

simulates what the finished piece will look like). You can simulate how your image’s colors 

will look on a mac or a pc monitor or in another color mode— even how a color-blind person 

would see them. This preview process, called soft proofing. 
 

Proof Color (Ctrl+Y). This command is used to turns soft proofing on or off. 
 

Gamut Warning (Ctrl+Shift+Y). This command is used to make Photoshop highlight areas 

of your image that fall outside of the safe color range, or gamut, for the color mode you’re 

working in. 
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Pixel Aspect Ratio. This command is used to you change the shape of your image’s pixels for 

specific projects.  
 

Pixel Aspect Ratio Correction. This command is used to feature on when you’re working 

with pixels that aren’t square so your images don’t look stretched when you view them on your 

computer monitor. 
 

32-Bit Preview Option. This command is used to dynamic range in 32-bit hdr images is 

greater than the color range most monitors can display, this option compensates for washed-

out highlights and overly dark shadows. 
 

Zoom In (Ctrl++). This command is used to works like a magnifying glass, increasing your 

image’s magnification level. 
 

Zoom Out (+-). This command is used to decreases your image’s magnification level. 
 

100%. This option adjusts your view of the current image and the window it’s in so that you 

are viewing it at 100% zoom level on your screen (otherwise known as actual size). 
 

200%. New in Photoshop CC, this command accommodates those users with a super high-

resolution Apple Retina or Windows HIDPI display and lets you view the current document 

at 200% zoom, which makes Web graphics appear at about the size visitors are likely to see 

“EM” in a web browser. 
 

Fit On Screen (Ctrl+0). This command is used to resizes the current image and the window 

it’s in to fill your monitor’s screen. 
 

Actual Pixel (Ctrl+1). This command is used to see your image at its actual size. 
 

Print Size. This command is used to changes the size of your image to show how big or small 

it will be when you print it. Resizing images for printing. 
 

Screen Mode. This command is used to you choose how you want to view your images. 
 

Extra (Ctrl+H). This command is used to you can add alignment helpers like guides and grids 

to your images. If you use one of these features, Photoshop will automatically turn on extras 

for you. 
 

Show. This command is used to lists the extra items you can display and use while you’re 

editing your images: guides, layer edges, notes, and more. 
 

Rulers (Ctrl+R). This command is used to shows or hides the horizontal and vertical rulers 

that run along the document window’s left and top edges. 
 

Snap. This command is used to turn snapping on or off. Snapping lets you align objects with 

guides and other items. 
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Snap To. This command is used to you choose which items objects will snap to: guides, grids, 

layers, slices, document bounds, or all of those things. 
 

Lock Guides. This command is used to prevent you from accidentally moving guides you’ve 

added to your images. If you’ve already locked your guides, use this command to unlock them. 
 

Clear Guides. This command is used to get rid of all the guides you’ve added to the current 

document. 
 

New Guides. This command is used to add vertical and horizontal guides to your image. 
 

Lock Slices. This command is used to keep slices. 
  

Clear Slices. This command is used to removes all the slices from the current image. 
 

Chapter-12. Window Menu. (Alt+W). 
 

 

 

Arrange Window. This command is used to organizing your open document windows. From 

here, you can do things like open and close panels, set the same magnification. Level across 

all your documents, minimize windows, and bring all your documents in front of other 

windows. 
 

Workspace. The items in this submenu rearrange Photoshop’s panels, menus, and tools to 

make it easier to perform certain tasks like painting or working with text. Page 10 explains 

workspaces and why you may want to use “EM”. 
 

Extensions. This command is used to extensions installed on your machine, like the new color-

scheme generator. 
 

3D. Choose this item to make Photoshop Extended display the 3D panel. 
 

Actions (Alt+F9). Choose this option to open the Actions panel, where you can see a list of 

the actions that came with Photoshop and ones you’ve created. You can also use this panel to 

manage actions. 
 

Adjustments. This panel lets you add Adjustment layers that you can use to nondestructively 

alter an image’s color and lighting. 
 

Animation. This command is used to displays the animation timeline and editing panel. 
 

Brushes (F5). This panel lets you select and edit Photoshop’s built-in brushes, as well as 

brushes you’ve created yourself. You more than you ever wanted to know about the Brush 

panel. 
 

Brushes Presets. This panel lets you view a painting sample, as well as edit and store your 

own customized settings for brushes. 
 

Channels. This panel shows the different color channels contained in your document. 



Vinod Computer Institute Mehnagar Azamgarh UP. 

--------------------------------------------------------------------------------------- 

60 | P a g e  
 

Character. The Character panel is where you can find all sorts of settings for working with 

text. 
 

 

Character Styles. This menu item lets you save and apply character text formatting options. 
 

Clone Source. This panel groups together settings for using the clone tools. 
 

Color (F6). Use this panel to view and change the foreground and background color chips at 

the bottom of your Tools panel via a series of sliders that correspond to your document’s 

current color mode. 
 

Histogram. This command is used to include a graph (called a histogram) that shows you 

information about the pixels in your image. 
 

History. This command is used to displays a timeline of the edits you’ve made to the current 

document. This panel also shows what the image looked like last time you saved it and lets 

you restore your image to any previous state. 
 

Info (F8). This panel includes info about where your cursor is, the color of the pixels it’s 

hovering over, and the size of your current selection if you have one has more about this panel. 
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Layer Comps. This command is used to view and organize groups of layers you can use to 

show different versions of your image in a single document. 
 

Measurement Log. This is where you can see data collected by the count tool. 
 

Navigator. This command is used to you change how much you’re zoomed in on your image 

and which part of the image you’re viewing. 

 

Notes. This command is used to view, edit, and delete notes from this panel. 
 

Paragraph (F6). This command is used to control the paragraph-wide settings for text in your 

documents. 
 

Paragraph Styles. This panel lets you create and apply paragraph-specific formatting options. 
 

Layers (F7). This command is used to add, delete, and organize your document’s layers from 

this panel. And give the special effects in image using the layer options. 
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Paths. This command is used to keep track of all the paths in your image using this panel. You 

can also use it to change the stacking order of the paths as well as add and delete them. 
 

Properties. This panel lets you tweak the settings for Adjustment layers as well as pixel- or 

vector-based layer masks. 
 

Styles. You can use this panel to apply Photoshop’s built-in styles to your images as well as 

create and save your own custom styles. 
 

 

 

Swatches. Here’s where you can view and pick colors from libraries of color chips. Photoshop 

includes a long list of popular libraries including several pantone, Toyo, and Trumatch color 

groups. 
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Timeline. This command opens the Timeline panel (named Animation in previous versions of 

the program) that you can use to create a frame-based animation or a video project complete 

with multiple clips, transitions, audio, and more. 
 

Tool Presets. If you regularly used the same settings for a particular tool, use this panel to 

save them as a preset so you can use them again later.  
 

Options. This command is used to shows or hides the options bar. 
 

Tools. This command is used to show or hide the tools panel. You’ll work with this panel all 

the time, so you’ll probably want to leave it visible. 
 

 

 

Open Documents. The bottom portion of the Window menu doesn’t actually have a label, but 

it’s where Photoshop lists all the documents you have open (in alphabetical order). 
 

Help Menu (Alt+H).  
 

 

 

Photoshop Online Help. Here’s where you can access Photoshop’s online help system but 

you need an active Internet connection. (That being said, you can download the help file to 

your computer as a PDF!). 
 

Photoshop Support Centre. This command launches the online Adobe Community Help 

program. You need an Internet connection and your Adobe ID to use it.  
 

Update. Choose this option to make Photoshop check for updates.  
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Chapter-13. Adobe Photoshop CC 2017. Keyboard Shortcut Key. 

Shortcut Key. Option. 

Accessibility Is the Key. 
F1.  Toggles Adobe Online Help.  

F2. Cut. 

F3. Copy. 

F4. Paste. 

F5. Toggles Brush Style Palette.  

F6. Toggles Color, Swatches, Styles Palette.  

F7.  Toggles Layers, Channels, Paths Palette.  

F8.  Toggles Navigator, Info Palette.  

F9.  Tab (Key) – Toggles All the Palettes On Screen.  

F12. Revert. 

Shift + Tab (Key).  Toggles Palettes On Screen, Excluding The Toolbar. 

Shift+F5. Fill. 

Shift+F6. Feather Selection. 

Shift+F7. Inverse Selection. 

Shortcuts Key Photoshop Tools. 

M.  Marque Tool.  

V. Move Tool.  

L. Lasso Tool.  

W. Magic Wand Tool.  

C. Crop Tool.  

K. Slice Tool.  

J. Healing Brush Tool.  

B. Brush Tool.  

S. Clone Stamp Tool.  

Y. History Brush Tool.  

E. Eraser Tool.  

G. Gradient Tool.  

R. Blur Tool.  

O. Sponge Tool.  

A. Direct Selection Tool.  

T. Type Tool.  

P. Pen Tool.  

U. 18 Rectangle Tool.  

N. Note Tool.  

I. Eyedropper Tool.  
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H. Hand Tool.  

Z. Zoom Tool.  

X. Swish Color.  

D. Default Color.  

Q. Stand Mode.  

F. Screen Mode.  

Out of (Ctrl) Short Cuts. 

Ctrl + N. New Document Dialogue Box.  

Ctrl + M. Curves Dialogue Box.  

Ctrl + A. Selects All in The Currently Foreground Document or 

Currently Selected Layer.  

Ctrl + D. Deselects All in The Currently Foreground Document or 

Currently Selected Layer.  

Ctrl + J. Automatically Creates a Duplicate of the Currently Selected 

Layer.  

Ctrl + K. Preferences Dialogue Box.  

Ctrl + L. Levels Dialogue Box.  

Ctrl + F4. Closes Current Document.  

Ctrl + '. (Single Quote Key) - Toggles Grid Lines.  

Ctrl + Q. Quits Photoshop Altogether.  

Ctrl + R. Toggles Rulers.  

Ctrl + U. Hue/Saturation Dialogue Box.  

Ctrl + O. Opens New File.  

Ctrl + P. Print Dialogue Box.  

Ctrl + Z. Undo Last Action.  

Ctrl + Tab. Toggle Between Open Documents.  

Ctrl + Shift + C. Copy Merged.  

Ctrl + C. Copy.  

Ctrl + H. Toggle Extras.  

Ctrl +; Toggle Guides.  

Ctrl + Shift +; Toggle Snap.  

Ctrl + X. Cut.  

Ctrl + Alt + Shift + X. Pattern Maker.  

Ctrl + V. Paste.  

Ctrl + Shift + V. Paste into Selection.  

Ctrl + Alt + Shift + V. Paste Outside.  

Ctrl + T. Transform Tool.  

Ctrl + Shift + T. Repeats The Last Performed Transform.  
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Shift + F5.  Fill Layer Dialogue Box. 

Ctrl + Shift / Alt. Combination Number 9 Shortcuts. 

Ctrl + Shift + O. Photoshop's File Browser.  

Ctrl + Shift + P. Page Setup Dialogue Box.  

Ctrl + Shift + S. Save As Dialogue Box.  

Ctrl + Shift + K. Color Setting Preferences Box.  

Ctrl + Shift + X. Liquefy Filter Tool.  

Ctrl + Shift + N.  Create New Layer Preferences Box.  

Ctrl + Shift + M.  Launches Image Ready.  

Ctrl + Shift + E.  Merges All Layers into A Single Layer.  

Ctrl + Alt + Z.  Step Backward.  

Ctrl + Shift + -. Zoom Out.  

Ctrl + Shift + +. Zoom In.  

Ctrl + Shift + Alt + N.  Creates A New Empty Layer.  

Ctrl + Shift + Alt + S.  Save For the Web Dialogue.  

Ctrl + Shift + I.  Inverts A Selection.  

File (Alt+F).  

Ctrl + W. Close. 

Ctrl + Shift + W. Close All. 

Ctrl + Shift + K. Color Setting. 

Ctrl + Shift + O. File Browser. 

Ctrl + N. New Document. 

Ctrl + Shift + Tab. Next Document. 

Ctrl + Alt + O. Open As. 

Ctrl + Shift + P. Page Setup. 

Ctrl + K. Preference. 

Ctrl + Q. Ouit. 

Ctrl + Shift + Alt + S. Save For Web. 

Ctrl + Alt + S. Save As. 

Ctrl + Alt + P. Print Option. 

Ctrl + S. Save. 

Ctrl + P. Print. 

Edit (Alt+E).  

Ctrl + C. Copy. 

Ctrl + Shift + C. Copy Merge. 

Ctrl + X. Cut. 

Ctrl + Alt + T. Duplicate Free Transform. 

Ctrl + Alt +X. Extract. 
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Ctrl + Shift + F. Fade Last Filter. 

Shift + Backspace. Fill Dialog. 

Ctrl + T. Free Transform. 

Ctrl + F. Last Filter. 

Ctrl + Shift + X. Liquefy. 

Ctrl + V. Paste. 

Ctrl + Z. Undo. 

Ctrl + Alt + Z. Step Backward. 

Ctrl + Shift + Z. Step Forward. 

Ctrl + Shift + V. Paste Into Selection. 

Ctrl + Shift + Alt + X. Pattern Maker. 

Ctrl + Shift + T. Free Transform Align. 

Ctrl + Alt + Shift + M. Menus. 

Ctrl + Alt + Shift + K. Keyboard Shortcut. 

Image (Alt+I).  

Ctrl + L. Level. 

Ctrl + M. Curve. 

Ctrl + U. Hue / Saturation. 

Ctrl + B. Color Balance. 

Ctrl + Alt + Shift + B. Black & White. 

Ctrl + I. Invert. 

Ctrl + Shift + U. Desaturate. 

Ctrl + Shift + L. Auto Tone. 

Ctrl + Alt + Shift + L. Auto Contrast. 

Ctrl + Shift + B. Auto Color. 

Ctrl + Alt + I. Image Size. 

Ctrl + Alt + C. Canvas Size. 

Ctrl + Y. Proof Color. 

Layer (Alt+L).  

Ctrl + Shift + N. New Layer. 

Ctrl + J. Copy Layer. 

Ctrl + Shift + J. Layer Via Cut. 

Ctrl + Alt + G. Create Clip Mask. 

Ctrl + C. Group Layer. 

Ctrl + Shift + G. Ungroup Layer. 

Ctrl + E. Merge Layer. 

Ctrl + Shift + E. Merge Visible. 

Ctrl + Shift + ]. Bring To Front. 
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Ctrl + ]. Bring To Forward. 

Ctrl + [. Send Backward. 

Ctrl + Shift + [. Send To Back. 

Select (Alt+S).  

Ctrl + A. Select All. 

Ctrl + D. Deselect. 

Ctrl + Shift + D. Reselect. 

Ctrl + Shift + I. Inverse. 

Ctrl + Alt + A. All Layer. 

Ctrl + Shift + Alt + F. Find Layers. 

Shift + F6. Feather. 

Filter (Alt+T).  

Ctrl + F. Last Filter. 

Ctrl + Shift + A. Adaptive Wide Angle. 

Ctrl + Shift + R. Lens Correction. 

Ctrl + Shift + X. Liquefy. 

Ctrl + Alt + V. Vanishing Point. 

View (Alt+V).  

Ctrl + Y. Proof Color. 

Ctrl + Shift + Y. Gamut Warning. 

Ctrl ++. Zoom In. 

Ctrl +-. Zoom Out. 

Ctrl + 0. Fit on Screen. 

Ctrl + 1. Actual Pixel. 

Ctrl + H. Extras. 

Ctrl + R. Ruler. 

Window (Alt+W).  

Alt + F9. Actions. 

F5. Brush. 

F6. Color. 

F7. Layer. 

F8. Info. 
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Chapter-14. Projects Creation in Adobe Photoshop CC 2017. 
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Practical Works in Adobe Photoshop CC 2017. 
 

Fire Effect. 

Step To Follow. 

 Open a new Document (Ctrl+N). Press (ok). And fill black color in the background (Ctrl  
 + Backspace). 
 Then go to the tool bar and select Text tool and write any text matter in work area. 
 And go to “Window” and Select “Layer (F7)”. Then go the “Function” and click on  
 “Gradient Overlay”. And fill two colors according to you. 
 Then Select Text Layer and go to the layer menu and Select “Merge Down” (Ctrl + E)  
 And merge both layers. 
 Then go to the “Image menu” and select “Image Rotation” and click on “90 degree  
 Clockwise”. 
 Then go to the “Filter menu” and select “Stylize” and click on “Wind”. And Select  
 “Wind” in method and Select “From the Left” in “Direction” then click “OK”. And Go  

 To the “Filter” and click on “Wind” (Alt + Ctrl + F) two times. 

 Then go to the “Image menu” and select “Image Rotation” and click on “90 degree  
 Counter Clockwise”. 

 Then go to the “Image menu” and select “Mode” and click on “Grayscale”. And then  
 Click on “Discard”. 
 Then go to the “Image menu” and select “Mode” and click on “Indexed Color”. And  
 Click “OK”. 
 Then go to the “Image menu” and select “Color Table” and click on “Black Body” and  
 Click “OK”. 

 

 Now your Fire Effect is ready. 
 

Rain Effect.  
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Step To Follow. 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to a File Menu and select the Open option (Ctrl+O) and Import any  

Image. 
 Then go to the “Layer” menu and select “New” and click on “Layer” (Shift + Ctrl + N).  

And go to the tool bar and select the “Paint Bucket Tool” and fill “Black color” in layer  

No. 2. 
 Then go to the Filter menu and Select the “Pixelate” and click on “Pointillize”. And  

“Cell Size to 6” and press “OK”. And go to Layer menu and click on “Layer Style” and  

Select “Blending Options” and change “Blend mode” to “Screen”. 
 Now go to the “Image” menu and select “Adjustments” and click on “Threshold”. And  

Increase “Threshold Level” to “231”. 
 Now go to the “Filter” menu and click on “Blur” and select “Motion Blur”. And increase  

“Angle” and “Distance” UPTO “46”. 

 Now your Rain Effect is ready. 
 

 
 

Water Effect.  
 

Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to a File Menu and select the Open (Ctrl+O) and Import any Image. And  

Decrease image size to half page. Then press (Ctrl+J) to Duplicate the image and press

 Ctrl +T Select top point of image and drag it downward. 
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 Go to “Filter” menu and Click on  “Blur” and select “Motion Blur” .And Increase  
“Angle” to “90” Degree and Increase “Distance” to “30”. 

 Go to the Filter menu and Click on “Distort” and select “Wave”. And increase “Number  
Of “Generators” to “100” and Set Wavelength Min. “1” and Max. “17” and Set  

“Amplitude” Min. “1” and Max. “20” and Set Scale “Horiz.” “100” and “Vert.” “1”. 

 Now your Water Effect is ready. 
 

 

 

Bubble Effect. 
  

Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok). 
We are going to a File Menu and select the Open (Ctrl+O) and Import any Image. 

 And Add a new layer and go to the Shape tool create “Oval shape”. Then go to “Gradient  
Tool” and fill Black and white gradient color in the oval shape. And go to the “Window”  

Menu and Select the “Layer” Option (F7) then go to Blending Mode and Change it to  

“Overlay”. 

 Now go to “Function” and Select “Inner Shadow”. And adjust it according to you. 
 Then again go to Function and Select “Drop Shadow”. And adjust it according to you. 
 Then again go to Function and Select “Bevel & Emboss”. And adjust it according to  

You. 
 Then make two or three copies of that oval Shape. 
 Now your Bubble Effect if ready. 
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Neon Text Effect.  

Step To Follow. 

 Open a new Document (Ctrl+N). Press (ok). 
 Then go to the “Layer” menu and click on “Layer Style” and select “Gradient Overlay”.  

And Increase Opacity to “28” and fill “Purple” gradient color and click on “Reverse” 

option then change “Style” to “Radial” and adjust “Angle” to “7 Degree” then click 

“OK”. 

 Now go to Text Tool and write any text on the work area. Then go to “Layer” menu and  
Click on “Layer Style” and select “Stroke”. And Increase stroke size to “5” then press 

“OK”. Then decrease Text layer fill from “100” to “0”. 
 Then Select text layer and Make a group of it (Ctrl + G). Then go to “Layer” menu and  

Click on “Layer Style” and select “Outer Glow”. And Increase Opacity to “100” then 

fill “Pink” color and increase its “Spread” to “13” and increase its “Size” to “18”       

press “OK”. 

 Now Your Neon Text Effect is ready. 
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Text Masking Effect.  
 

Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok).  
 Now go to file Menu and select Open Option and Import any image (Ctrl+ O). 
 We are going to select the Text tool from the toolbox and Write any Text Matter in  

Work area. 
 Now Go to Layer menu and Click on “Create Clip Mask” (Alt + Ctrl+ G) to Power clip   

Both Image and Text layers. 

 Now go to “Function” and Select “Bevel & Emboss”. And adjust it according to you. 
 Now go to “Function” and Select “Drop Shadow”. And adjust it according to you. 
 Then go to the “Layer” menu and click on “Layer Style” and select “Gradient Overlay”.  

And Increase Opacity to “28” and fill “Gray” gradient color and click on “Reverse” 

option then change “Style” to “Radial” and adjust “Angle” to “7 Degree” then click 

“OK”. 

 Now your Text Masking Effect is ready. 
 

 



Vinod Computer Institute Mehnagar Azamgarh UP. 

--------------------------------------------------------------------------------------- 

81 | P a g e  
 

 

 

 

Text Burst Effect.  
 

Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to layer no. 1 and select the Text tool from the toolbox and Write any  

Text Matter in work area.  

 Go to “Layer” menu and click on “Layer Style” and select “Gradient Overlay”. And  

Fill Gradient color in text matter according to you. 

 Go to “Layer” menu and click on “Layer Style” and select “Bevel & Emboss”. And  

Adjust according to you. 

 Now select text layer and make three copies of it (Ctrl + J). And Select all three Layer  
By pressing Ctrl Key and then go to “Blending Mode” and change it to “Dissolve”. Then  

Right click on selected three copied Layers and select “Rasterize Type”  

Option. And again select all three copied layers and press right click and select “Merge  

Layers” option. 
 Then go to Filter menu and click on “Blur” option and select “Radial Blur”. And  

Increase blur “Amount” to “100” and select “Zoom” in “Blur “Method” and select  

“Best” in “Quality” option. 
 Now go to “Blending Mode” and Select “Linear Dodge (Add)”. And again go to Filter  

Menu and click on “Blur” option and select “Radial Blur”. And increase blur “Amount”  
to “100” and select “Zoom” in “Blur “Method” and select “Best” in “Quality” option. 

 Now make a copy of text layer (Ctrl+J). 
      Now Your Text Burst Effect if ready. 
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Mask Effect.  
 

Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to a File Menu and select the Open (Ctrl+O) and Import any face Image. 

 Then take a new layer (Ctrl+ Shift + N) and again import another face image. And adjust  
It on the first image. 

 Go to “Layer” menu and click on “Layer Mask” and select “Reveal All”.  

 Now set the foreground color “Black” and background color “White”. 
 Then go to the “Edit” menu and click on “Fill” (Shift + F5) and Select “Foreground  

Color” in “Use” option then click “OK”. 

 Now change the foreground color “White” and background color “Black”. 
 Then go to the “Tool” bar and select the “Brush” tool and press and hold the Left button  

Of mouse and move brush on the image. 
 Now your Mask effect is ready. 
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Wooden Texture Effect.  
 

Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok). 
 Now set light brown color in the “Foreground color” and fill dark brown color in  

“Background color”. Then go to “Filter” menu and click on “Render” and select  

“Clouds”. Then go to “Filter” menu and click on “Render” and select “Fibers”. 
 Then take a new layer and fill same color in it. And go to Filter menu and click on  

“Noise” and select “Add Noise” select “Uniform” in “Distribution” and highlight  

“Monochromatic” then click “OK”. 
 Now go to “Filter” menu and click on “Blur” and select “Motion Blur”. And set “Angle”  

“90 Degree” give “Distance” “65 pixels”. Then go to “Blending Mode” and select 

“Subtract” option. And now go to “Layer” menu and click on “Merge Down” (Ctrl+E). 
 Now go to “Edit” menu and click on “Define Pattern” and click “OK”. 
 Then go to “Tool Bar” and select “Text Tool” and write any text. Now go to “Layer”  

Menu and click on “Layer Style” and select “Pattern Overlay” and select your Pattern. 
 Again go to “Layer” Menu and click on “Layer Style” and select “Bevel & Emboss”  

And select “Outer Bevel” From “Style”. 

 Now your wooden texture effect is ready. 
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Gradient Mask Effect.  
 

Step To Follow.1 
 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to “File” Menu and select the “Open” (Ctrl+O) and Import any Image. 
 Again go to “File” Menu and select the “Open” (Ctrl+O) and Import another Image.  

And drag it on first image and cover the whole image. 
 Then go to “Layer” menu and click on “Layer Mask” and select “Reveal All”. 
 Then go to “Tool Bar” and select “Gradient Tool” and select “Black & White Gradient”  

Color. And Drag it on the Image. 

 
 

Text Reflection Effect.  
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Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to “File” Menu and select the “Open” (Ctrl+O) and Import any Dark  

Background Image. 
 Then go to “Tool Bar” and select “Text Tool” and write any text in work area.  
 Now go to “Layer” Menu and click on “Layer Style” and select “ Bevel & Emboss” and  

Select “Inner Bevel” in “Style”. 
 Again go to “Layer” Menu and click on “Layer Style” and select “Gradient Overlay”. 
 Again go to “Layer” Menu and click on “Layer Style” and select “Drop Shadow”. 
 Now go to “Layer” Menu and click on “New” and select “Layer Via Copy” (Ctrl+J). 
 Now go to “Edit” Menu and click on “Transform” and select “Flip Vertical”. And drag  

Copied text to the bottom of original text. And go to the Layer option and decrease the  

Opacity to 20%. 
 Now Your Reflection Effect is ready. 
 

 

 

Dispersion Effect.  
 

Step To Follow. 
 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to “File” Menu and select the “Open” (Ctrl+O) and Import any Model’s  

image. 
 Now go to “Tool Bar” and click on “Quick Selection Tool” and select only model’s  

Image  
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With it. Then go to “Layer” menu click on “New” and select “Layer via Copy” (Ctrl+J). 
 Now go to original layer and then go to “Layer” menu and click on “Layer Mack” and   

Select “Reveal All”. Then fill black color in it. 
 Then go to “Filter” menu and click on “Liquefy” and stretch the image as you want then  

Press “OK”. 
 Now go copied layer and again go to Layer menu and click on Layer Mack and select  

Reveal All. Then fill white color in it.  And change foreground color to “Black”. Then  

Go to Tool bar and select Brush tool and drag it on image as u want to remove some  

Part of image. 

 Now go to Original Layer and again change foreground color to “White”. Then go to  
Tool bar and select Brush tool and drag it on image as u want to Spread pixels of the  

Image. 
 Now your Desperation effect is ready.  
 

 
 

Ink Splash Effect. 

Step To Follow. 

 Open a new Document (Ctrl+N). Press (ok). 
 We are going to “File” Menu and select the “Open” (Ctrl+O) and Import Ink splash  

Image. 
 Again we are going to “File” Menu and select the “Open” (Ctrl+O) and Import any  

Model’s image. 
 Now go to the “Tool” bar and select “Quick Selection Tool” and select the image and  
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Press “Right” click and select “Layer Via Copy”. And go to “Blending Mode” and  

Select “Lighten”. And Hide the Original Layer. 
 Now go to “Image” menu and click on “Adjustments” and select “Desaturate”. 

 Again go to “Image” menu and click on “Adjustments” and select “Threshold”.  

 Then Press (Alt + Ctrl + Shift + E) for copy whole Layer into a new layer.  

 Now go to Filter” menu and click on Lens Correction”. Then in Lens correction click  

On Custom” and Change Vignette amount to -30 and change Midpoint to +68 then press  

“OK”. 

 Now your Ink Splash effect is ready.  
 

 

 

 
 


